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1 Vorwort 

Dieses Dokument soll eine Einführung in das kostenlose Simulationstool LTspice IV 

bieten. Neben den Erläuterungen der Funktionen des Programms zum Simulieren 

von elektrischen Schaltungen soll hier eine Übersicht über die Möglichkeiten der Er-

stellung eigener Simulationsmodelle bzw. die Verwendung von Modellen fremder 

Hersteller erläutert werden. 

Für detailliertere Informationen zu bestimmten Funktionen kann die ausführliche 

Hilfefunktion (drücken der F1-Taste) verwendet werden. Zusätzlich steht ein Hand-

buch (pdf-Format) im Installationsverzeichnis von LTspice zur Verfügung. 
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2 Installation 

2.1 LTspice IV Programminstallation 

Für die LTspice IV Programminstallation wird empfohlen nicht vom vorgeschlage-

nen Standard abzuweichen. Hier wird als Installationsverzeichnis üblicherweise 

 C:\Programme\LTC\LTspiceIV 

vorgeschlagen. Dieses Tutorial ist darauf aufgebaut, LTspice in dem genannten Ver-

zeichnis vorzufinden. Da das Installationsverzeichnis für die Arbeit mit LTspice sehr 

wichtig ist, sollte es nicht an einem anderen Ort installiert werden. 

2.2 Installation der _HochschuleKarlsruhe Bibliothek 

Die Bibliothek der Hochschule Karlsruhe kann unter 

 http://www.home.hs-karlsruhe.de/~klal0001/.../ 

heruntergeladen werden. 

Nach der Installation von LTspice IV befinden sich unter 

 C:\Programme\LTC\LTspiceIV\lib\ 

die Ordner <sub> und <sym>. Im Ordner <sub> sind die Bibliotheken der verschie-

denen Simulationsmodelle hinterlegt, während sich die zugehörigen Symbolblöcke 

(Symbole der Bauteile auf dem Schaltplan) im Ordner <sym> befinden. Die 

<_HochschuleKarlsruhe> Bibliothek ist nach demselben Schema in die zwei Teile 

<_hskaSub> (Modelle) und <_HochschuleKarlsruhe> (Symbole) aufgeteilt. Die Ord-

ner mit den Symbolen/Modellen müssen an der entsprechenden Stelle 

 C:\Programme\LTC\LTspiceIV\lib\sub\_hskaSub 

 C:\Programme\LTC\LTspiceIV\lib\sym\_HochschuleKarlsruhe 

abgelegt werden. Die Modelle sind so programmiert worden, dass sie in den genann-

ten Verzeichnissen gesucht werden. Befinden sich die Dateien an einem anderen Ort, 

können sie nicht ohne weiteres in den Schaltplan eingefügt werden. 

Alternativ können die Symbole im Arbeitsverzeichnis (Verzeichnis in dem der 

Schaltplan zur Simulation abgespeichert ist) abgelegt werden. Dann können sie zwar 

in den Schaltplan eingefügt werden, jedoch kann der Simulator die verknüpften Mo-

dele nur dann finden wenn im Schaltplan die SPICE Direktive 

 .lib C:\..\_hskaSub 

(Pfad des Speicherortes des Modellordners) eingefügt wird. Der Einfachheit halber 

wird jedoch die zuerst genannte Methode empfohlen. 
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3 Einführung in LTspice IV 

LTspice ist ein Simulationsprogramm, das auf dem viel verwendeten SPICE Simula-

tor der Universität Berkeley basiert. Es wird von der Firma Linear Technology zur 

kostenfreien Nutzung angeboten. 

Zur einfachen Verwendung des Simulators stellt LTspice die beiden Funktionen 

„Schematic Capture“ zur Erstellung des Schaltplans und „Waveform Viewer“ zur 

Visualisierung der Simulationsergebnisse zur Verfügung. Der gezeichnete Schaltplan 

wird von Schematic Capture dazu verwendet eine so genannte „Netlist“ zu erzeu-

gen. Diese Netlist wird im selben Ordner abgespeichert, in dem der Benutzer den 

Schaltplan gespeichert hat (nachfolgend „Arbeitsverzeichnis“ genannt). Sie kann mit 

einem Texteditor geöffnet und bei Bedarf verändert werden. Bei der Netlist handelt 

es sich um eine Auflistung aller Bauelemente, die im Schaltplan verwendet wurden 

und der Knotenpunkte an denen die sie miteinander verbunden sind. Die Anzahl der 

verfügbaren Bauelemente (im Folgenden „Basiselemente“ genannt) ist mit 23 Stück 

scheinbar gering, jedoch umfasst die Modellierung eine Fülle von Parametern, deren 

Anpassung die Simulation einer Vielzahl von realen Bauteilen ermöglicht. Die Para-

metrierung der Modelle geschieht durch das zur Verfügungstellen von Bibliotheks-

dateien. Welche Modelle den Basiselementen zu Grunde liegen und welche Parame-

ter beeinflusst werden können, ist in der LTspice Hilfe unter dem Stichwort „Circuit 

Elements“ beschrieben. 

Zur eigentlichen Simulation verwendet SPICE die Informationen in der Netlist und 

generiert eine .raw Datei, die ebenfalls im Arbeitsverzeichnis abgelegt wird. In ihr 

sind die Ergebnisse der Simulation hinterlegt, die durch Waveform Viewer visuali-

siert werden. 

 

3.1 Überblick 

Nach dem Start des Programms erscheint ein zunächst ein leeres Fenster. 

 

 

Abbildung 1: Fenster nach dem Programmstart 
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Der Schematic Capture und Waveform Viewer können von hier aus genutzt werden 

Die verfügbaren Funktionen zeigt folgende Liste: 

 

 

 Neues Schematic 

 Datei öffnen 

 Datei speichern 

 Aufruf Control Panel 

 Simulation starten 

 Simulation anhalten 

 Verschiedene Zoomfunktionen 

 Auswahl der angezeigten Kurven im Waveform Viewer 

 Automatische Skalierung der Y-Achse im Waveform Viewer 

 Verschiedene Aufteilung der aktiven Fenster 

 Copy/Paste Funktionen 

 Druckfunktionen 

 Elektrische Verbindung zeichnen 

 Massesymbol platzieren 

 Labelfunktion zur freien Bezeichnung von Knotenpunkten 

 Widerstand platzieren 

 Kondensator platzieren 

 Spule platzieren 

 Diode platzieren 

 Bauteil Datenbank öffnen 

 Verschieben von Bauteilen 

 Rückgängig/Wiederholen 

 Bauteil drehen/spiegeln 

 Kommentar platzieren 

 SPICE Direktive platzieren 
 

Tabelle 1: Auflistung der Funktionsbuttons im LTspice Fenster 
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Nicht alle Funktionen des Programms können durch Verwendung der Maus genutzt 

werden. Um die volle Funktionalität des Simulators ausnutzen zu können, müssen 

neben den grundlegenden Einstellungen auch bestimme Befehle, die so genannten 

SPICE Direktiven, an den Simulator übergeben werden. 

Viele Funktionen sind zusätzlich über frei einstellbare Hot Keys erreichbar. Sie kön-

nen unter 

Button <Control Panel>, Register <Drafting Options>, Button <Hot Keys[*]> 

verändert  werden. 

 

 

3.2 Ein erstes Beispiel 

 

Zur Erläuterung der Arbeitsweise von LTspice IV soll ein RC-Tiefpass simuliert wer-

den. Nach dem Starten des Programms wird ein neuer Schaltplan (Schematic) erstellt 

und die notwendigen Bauteile (Widerstand, Kondensator, Massesymbol) durch die 

Verwendung der entsprechenden Buttons platziert. Die Spannungsquelle kann über 

die Bauteildatenbank hinzugefügt werden. Hierzu wird nach dem Klick auf den But-

ton zum Öffnen der Datenbank der Ordner [_HochschuleKarlsruhe] geöffnet. Hier 

befinden sich die Symbole der Bauteilbibliothek der Hochschule. Ein einzelner Klick 

auf einen Bauteilnamen zeigt das entsprechende Symbol im Vorschaufenster und 

eine Kurzbeschreibung des Bauteils. Ein Doppelklick auf den Bauteilnamen schließt 

das Dialogfenster und heftet das Bauteil an den Mauszeiger. 

Hinweis: Das Drehen von Bauteilen kann entweder durch Verwendung des entspre-

chenden Buttons oder per Hot Key (<STRG>+<R>, falls nicht umdefiniert) erfolgen. 

Nach dem Verbinden fehlen den Bauteilen noch die notwendigen Parameter. Durch 

einen Klick mit der rechten Maustaste auf ein Bauteil öffnet sich ein Dialogfenster. Je 

nach verwendetem Modell (selbst definiert, Fremdhersteller oder LTspice Original) 

sieht dieses Feld unterschiedlich aus. Einzige Funktion aller Dialogfenster ist in die-

sem Zusammenhang die Übergabe verschiedener Parameter an das verwendete Mo-

dell. 
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Abbildung 2: Attributfenster des Kondensators 

 

Etwas komplizierter stellt sich die Parametrierung der Spannungsquelle dar. Das 

Attributfenster bietet den Button <Advanced>, mit dem das Fenster um verschiedene 

Funktionen vergrößert werden kann. Die genaue Erklärung der einzelnen Parameter 

bzw. Funktionen ist sehr gut in der LTspice Hilfe (drücken der <F1> Taste) erklärt 

und soll hier nicht näher beschrieben werden. Für die Parametrierung können ver-

schiedene Schreibweisen verwendet werden. LTspice interpretiert hierbei auch Buch-

staben, die der Zahl folgen. Daher können Multiplikatoren verwendet werden. Es 

gilt: 

1 Millivolt = 1m = 1mV = 1e-3 = 1e-3V 

Hierbei können jeweils der erste Buchstabe des jeweiligen Multiplikators verwendet 

(k: Kilo, u: Mikro, p: Pico, f: Femto, usw.). Einzige Ausnahme ist der Multiplikator 

Mega, dieser wird durch „meg“ Repräsentiert. 

Vorsicht Falle: Der Multiplikator Mega muss als „meg“ hinterlegt werden. Da SPICE 

nicht zwischen Groß- und Kleinbuchstaben unterscheidet wird 1M als 1 Milli inter-

pretiert. Außerdem wird f (oder F) als Femto interpretiert. Bei der Simulation von 

großen Kapazitäten (z.B. 2 Farad) muss die Einheit weggelassen werden, denn 2f (o-

der 2F) würde als 2 Femtofarad interpretiert. 

Grundsätzlich ist die Notation von Einheiten nicht notwendig, da Buchstaben, die 

auf den Multiplikator folgen von SPICE ignoriert werden. 

Der RC-Tiefpass soll für unser Beispiel mit folgenden Parametern versehen werden: 

R = 1 kΩ 

C = 1 μF 
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3.2.1 Transientenanalyse 

Die Transientenanalyse ermöglicht die Simulation von Schaltungen im Zeitbereich. 

So kann beispielsweise die Sprungantwort des Tiefpasses betrachtet werden. Dazu 

muss zunächst ein Spannungssprung auf den Tiefpass geschaltet werden. Dies kann 

durch die Parametrierung der Spannungsquelle mit der Funktion „Pulse“ erfolgen. 

In unserem Beispiel soll sie folgendermaßen eingestellt werden. 

 

Parameter Wert Bedeutung 

Vinitial[V] 0 Spannung im Auszustand 

Von[V] 5 Spannung im Einzustand 

Tdelay[s] 2u Startverzögerung 

Trise[s] 1n Anstiegszeit 

Tfall[s] 1n Abfallzeit 

Ton[s] 1m Einschaltzeit 

Tperiod[s] 1m Periodendauer 

Ncycles  Anzahl Perioden 
 

Tabelle 2: Parametrierung der Spannungsquelle mit Pulse-Funktion 

 

Nach der Parametrierung aller Bauteile müssen abschließend die Rahmenbedingun-

gen für die Simulation gewählt werden. Mit einem Klick der rechten Maustaste auf 

einen freien Bereich im Schaltplan erscheint ein Menü, aus dem 

 <Edit Simulation Cmd.> 

ausgewählt werden muss. Im erscheinenden Dialogfenster können die verschiedenen 

Simulationsarten ausgewählt und eingestellt werden. Für die Sprungantwort unseres 

Tiefpasses muss lediglich die <Stop Time> auf 10 us eingestellt werden. Der Parame-

ter <Time to Start Saving Data> bestimmt den Zeitpunkt, ab wann die Simulationser-

gebnisse in der .raw-Datei gespeichert werden. Dies kann verwendet werden, um 

Einschwingvorgänge zu verwerfen, wenn nur der eingeschwungene Zustand inte-

ressant ist. Einziger Effekt dieser Option ist eine kleinere .raw-Datei, da die Vorgänge 

vor dem Start der Aufzeichnung ebenfalls simuliert werden müssen, hat diese Opti-

on keinen Einfluss auf die Simulationsdauer. Die dritte Option <Maximum Time-

step> ermöglicht dem Benutzer die maximale Größe eines Simulationsschrittes zu 

beeinflussen. Ob diese Option für unseren Fall hilfreich ist, kann später anhand des 

Simulationsergebnisses geprüft werden. Die restlichen Optionen sind für unsere 

Zwecke nicht notwendig und können bei Bedarf in der LTspice Hilfe nachgelesen 

werden (Stichwort: Dot Commands). Wird die Einstellung der Simulation durch Kli-

cken auf <OK> beendet, ist das Ergebnis der Einstellung (eine SPICE Direktive) an 

den Mauszeiger geheftet und muss an einer freien Stelle im Schaltplan abgelegt wer-
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den. Fortgeschrittene Benutzer können die SPICE Direktive zur Einstellung der Si-

mulation, auch ohne das Dialogfenster zu benutzen, durch Verwendung des Buttons 

 <SPICE Direktive Platzieren> 

oder per Hot Key einfügen. 

Ein Klick auf den Button 

 <Simulation starten> 

startet die Simulation. 

Der Waveform Viewer öffnet sich automatisch nach Beenden der Simulation. Nun 

können im Schematic-Capture-Fenster durch Klicken auf Knotenpunkte oder Bautei-

le Spannungen und Ströme im Waveform Viewer angezeigt werden. Spannungen 

werden dann immer gegen Masse gemessen Das Klicken, Halten und Verschieben 

des Mauszeigers von einem Knotenpunkt zu einem anderen ermöglicht das Messen 

einer Spannung zwischen zwei Punkten. 

Hinweis: Wird der Schaltplan nach dem Durchlauf der Simulation geändert und er-

neut simuliert, werden die Knotenpunkte eventuell neu benannt. Kurvenverläufe, 

die bereits zuvor im Waveform Viewer angezeigt wurden, zeigen plötzlich einen 

ganz anderen Verlauf, obwohl dies nicht erwartet wird. In diesem Fall muss der 

Kurvenverlauf gelöscht und neu eingefügt werden. Abhilfe kann hier geschafft wer-

den, indem den interessanten Knotenpunkten – von Hand – Namen zugeteilt wer-

den. Dazu kann der Button 

 <Labelfunktion> 

verwendet werden. 

Im Waveform Viewer kann die Achseneinteilung durch einen Klick auf die jeweilige 

Achse (es erscheint ein Linealsymbol) verändert werden. 

Neben den Spannungen an Knotenpunkten und Strömen können auch Berechnun-

gen aus diesen Werten angezeigt werden. Das Klicken mit der rechten Maustaste auf 

den Namen eines bereits hinzugefügten Kurvenverlaufs öffnet ein Dialogfenster in 

dem eine Funktion (z.B. <V(N001)*I(R1)>) eingegeben und angezeigt werden kann. 

Um die Plausibilität der Kurvenverläufe zu prüfen, gibt es die Möglichkeit die vom 

Simulator berechneten Punkte anzeigen zu lassen: im Simulatorfenster nach einem 

Rechtsklick <Mark Data Points> auswählen. Ist in einem interessanten Bereich der 

Simulation die Dichte der Datenpunkte zu gering, kann sie durch die Vorgabe des 

maximalen Simulationsschrittes (im Fenster <Edit Simulation Cmd>) erhöht werden. 

Mehr Informationen zur Nutzung von Schematic Capture und Waveform Viewer 

finden sich in der LTspice Hilfe. 

Das Ergebnis der Simulation sieht folgendermaßen aus: 
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Abbildung 3: Simulation der Sprungantwort des Tiefpasses 
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3.2.2 AC-Analyse 

Die AC-Analyse ist die Simulation einer Schaltung im Frequenzbereich. Für unser 

Tiefpassbeispiel muss die Spannungsquelle, wie auch bei der Transientenanalyse, für 

diese Simulation eingestellt werden. Das Attributfenster bietet die Möglichkeit die 

Amplitude (Bereich: Small Signal AC Analysis) einzustellen. In unserem Beispiel soll 

sie auf 1 eingestellt werden. Durch die Einstellung der Eingangsamplitude auf „1“ 

erhält man das vom Bodeplot bekannte Amplituden- und Phasendiagramm. Zusätz-

lich muss die SPICE Direktive zum Einstellen der Simulation verändert werden. Dies 

kann durch einen Rechtsklick auf die bereits vorhandene .tran Direktive geschehen. 

Es öffnet sich das gewohnte Dialogfenster. Im Register <AC Analysis> können die 

Optionen eingestellt werden. Mit der Simulationsart <Decade> und 101 Punkten je 

Dekade ergibt sich das folgende Ergebnis (Abbildung 4) aus der AC Analyse für den 

Bereich von 1 kHz bis 1 MHz. 

 

Abbildung 4: Ergebnis der AC Analyse des Tiefpass 

 

Das Auswählen der Ausgangsspannung für die Anzeige im Waveform Viewer er-

stellt automatisch das gezeigte Ergebnis. Die durchgezogene Linie zeigt den 

Amplituden-, und die gestrichelte Linie den Phasengang der Ausgangsspannung. 

Die Anzeige des Phasenwinkels kann durch Klicken auf die rechte y-Achse (es er-

scheint wieder das Linealsymbol) mit dem Button 

 <Don’t plot phase> 

unterdrückt werden. Für einen Plot, der nur den Phasenwinkel enthält, kann auch 

das beschriebene Verfahren auch auf der linken y-Achse angewendet werden. 

Die genaue Beschreibung der genannten und übrigen Simulationsmöglichkeiten 

kann in der LTspice Hilfe nachgelesen werden. 
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4 Verwendung von externen SPICE Modellen 

Viele Hersteller bieten für ihre Bauelemente SPICE-Modelle an. Diese können auf 

unterschiedliche Art und Weise verwendet werden. Es sind folgende Fragen zu stel-

len: 

  Handelt es sich bei dem zu simulierenden Bauelement um ein Basiselement? 

  Soll das neue Modell nur einmalig verwendet werden? 

 

4.2 Nutzung von Modellen für Basiselemente 

Die Verwendung von Modellen für Basiselemente soll am Beispiel des Transistors 

BC847C erläutert werden. Beim Bipolartransistor handelt es sich um ein Basisele-

ment. LTspice stellt eine Vielzahl von Bauteilmodellen für den Bipolartransistor zur 

Verfügung. Ist dieses Modell des Basiselements ausreichend, um das entsprechende 

Bauelement zu simulieren, bieten die Hersteller Modelldateien an, die lediglich das 

Basiselement mit einer Liste von Parametern versorgen. Im Fall des BC847C wird die 

Modelldatei vom Hersteller ON Semiconductor unter 

 http://www.onsemi.com/pub_link/Collateral/BC847CDXV6T1.SP3 

angeboten. Sie kann mit einem Texteditor geöffnet werden (Abbildung 5). 

Die zulässigen Dateiformate für LTspice sind 

 .lib 

 .sub 

 .mod 

 

 

Abbildung 5: Modelldatei des Transistors BC847B 

 

Die Beschreibung des Bauteils in Abbildung 5 beginnt mit der Direktive 
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<.model >, gefolgt von einer Liste von Wertzuweisungen. Daran zeigt sich, dass diese 

Modelldatei lediglich Parameter für das Basiselement zur Verfügung stellt. Deshalb 

wurde sie (entgegen dem Beispiel des Herstellers) im .mod Format abgespeichert. 

Welches Format gewählt wird, spielt für den Simulator keine Rolle, da es sich bei den 

zulässigen drei Formaten ausschließlich um ASCII-Formate handelt, die alle mit ei-

nem Texteditor geöffnet und verändert werden können. 

4.2.2 Einmalige Nutzung 

Soll das Modell für den BC847C nur einmal benutzt werden, ist die schnellste Mög-

lichkeit der Bereitstellung das Abspeichern der Modelldatei (hier: 

BC847CDXV6T1.mod) im Arbeitsverzeichnis. Um das Transistormodell zu verwen-

den wird ein Bipolartransistor auf dem Schaltplan platziert. Danach wird ein Rechts-

klick auf die Bauteilbeschriftung „NPN“ (Name des verwendeten Modells) ausge-

führt. Im erscheinenden Attributfenster wird die Bezeichnung „NPN“ durch den 

Namen des Modells (Ausdruck hinter der .model Direktive, hier: BC847CDXV6T1) 

ersetzt. Zusätzlich muss dem Simulator noch mitgeteilt werden, wo er das Modell 

findet. Hierzu wird die SPICE Direktive 

 <.include bc847cdxv6t1.mod> 

auf dem Schaltplan platziert. Jetzt steht das Modell des BC847C zur Simulation be-

reit. Sollte es in einer anderen Simulation nochmals benötigt werden, muss die .mod- 

Datei im Arbeitsverzeichnis der neuen Simulation abgespeichert sein. Dann kann 

auch hier mit dem BC847C simuliert werden. 

4.2.3 Mehrfache Nutzung 

Bei regelmäßiger Nutzung eines Modells für ein Basiselement, das nicht in LTspice 

hinterlegt ist, gibt es wiederum zwei Möglichkeiten die Modellinformationen in 

LTspice einzubinden. Zum einen kann es in die Bibliothek des entsprechenden Basi-

selements – in diesem Fall des Bipolartransistors – eingefügt werden. Diese sind un-

ter 

 C:\Programme\LTC\LTspiceIV\lib\cmp 

zu finden. Dann kann das Bauelement im Attributfenster des Basiselements mit dem 

 <Pick New> 

Button erreicht werden. 

Alternativ kann mit Benutzung des bereits bestehenden Transistorsymbols ein Sub-

circuit erstellt werden, in dem das neue Modell aufgerufen wird. In diesem Fall er-

scheint das neue Modell in der Bauteildatenbank als neues, zusätzliches Element. Die 

Erstellung dieser Subcircuits wird in Kapitel 5.3 beschrieben. 
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5 Anlegen eigener Modelle 

Um die Simulation komplexer Schaltungen übersichtlich zu halten, empfiehlt es sich 

den Schaltplan auf verschiedene Anteile aufzuteilen. Die Möglichkeit hierzu ist die 

Verwendung von „Subcircuits“ und „Hierarchical Blocks“. Der Begriff „Hierarchical 

Block“ beschreibt die Verknüpfung zwischen einer Schaltplandatei (.asc Format) und 

einem Symbol und Subcircuit mit einer Netlist (.net Format). Nach dem Erstellen 

kann ein Hierarchical Block vom übergeordneten Schaltplan geöffnet, betrachtet und 

verändert werden. Der Schaltplan wird folglich in mehrere Ebenen aufgeteilt. Da bei 

Subcircuits das Symbol mit einer Netlist verknüpft wird, geht die grafische Darstel-

lung verloren. Soll eine Änderung vorgenommen werden, muss entweder der Code 

der Netlist direkt geändert werden, oder es wird eine neue, geänderte Netlist gene-

riert und angefügt. 

Aufgrund dieser Eigenschaften zeigt sich, dass sich Hierarchical Blocks sehr hilfreich 

sind um große Schaltpläne übersichtlich zu halten. Soll ein Schaltungsteil jedoch häu-

figer und für mehrere Simulationen verwendet werden, bietet sich die Zusammen-

fassung dieses Schaltungsteils als Subcircuit an. 

Die Symbole beider Ansätze können in die Bauteildatenbank eingefügt und von dort 

aus in den Schaltplan übernommen werden. 

 

5.1 Hinweis zum Abspeichern von Dateien 

Wie in den vorigen Kapiteln erwähnt bestehen alle Elemente, die in einen Schalplan 

in LTspice eingefügt werden können, aus einem Symbol und einem Modell (bzw. 

Netlist oder Schaltplan). Nach der Installation von LTspice sind die Symbole der von 

LT zur Verfügung stehenden Elemente unter 

 C:\Programme\LTC\LTspice IV\lib\sym 

die dazugehörigen Basiselemente unter 

 C:\Programme\LTC\LTspice IV\lib\cmp 

und die übrigen Modelle unter 

 C:\Programme\LTC\LTspice IV\lib\sub 

abgespeichert.  

Aus dem Ordner <sym> gewinnt LTspice seine Bauteildatenbank. Alle Symbole, die 

in <sym> oder einem Unterordner gespeichert sind werden – mitsamt der Ord-

nerstruktur – im Dialogfenster der Bauteildatenbank angezeigt. Zusätzlich kann das 

Arbeitsverzeichnis ausgewählt werden. Es ist nicht möglich, Symbole, die an einem 

anderen Ort gespeichert sind, in den Schaltplan einzufügen. LTspice sucht bei einer 

Simulation immer im <sub> Ordner und im Arbeitsverzeichnis nach den Modellen 
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der (in den Schaltplan eingefügten) Symbole. Hier kann LTspice keine untergeordne-

ten Verzeichnisse durchsuchen. Ist ein Modell in einem Unterordner hinterlegt muss 

dies entweder mit einer SPICE Direktive, z.B. 

 .lib <ordnername>\<bibliothekname.format> 

angezeigt, oder im Attributfenster des Symbols vermerkt werden. Ansonsten kann 

LTspice nicht mit diesem Modell simulieren. 

Zusammengefasst: Für regelmäßige Nutzung können Symbole im Ordner <sym> o-

der einem Unterordner von <sym> abgelegt werden. Die Ordnerstruktur innerhalb 

des <sym> Verzeichnisses wird von LTspice erkannt und beachtet. Die dazugehöri-

gen Modelle können in <sub> oder einem Unterordner gespeichert werden. Sind die 

Modelle in einem Unterordner gespeichert MUSS dies dem Simulator mitgeteilt 

werden. Bei der Suche nach Modellen beachtet LTspice die Ordnerstruktur nicht au-

tomatisch. 

 

5.2 Hierarchical Blocks 

Wie bereits erwähnt ist ein Hierarchical Block die Verknüpfung zwischen einem 

Symbol und einer Schaltplandatei. Wie ein solcher Block erstellt wird, soll an einem 

Beispiel erläutert werden. Unser Tiefpass aus Kapitel 3 soll als Bauelement zur Ver-

fügung stehen, bei dem Kapazität und Widerstand einstellbar sind. 

Zunächst öffnen wir den Schaltplan des Tiefpasses und entfernen die SPICE-

Direktiven für die Simulationseinstellungen. Diese wird nicht mehr benötigt, da die 

Simulation später vom übergeordneten Schaltplan aufgerufen wird. Außerdem kann 

die Spannungsquelle entfernt werden, da das Eingangssignal ebenfalls aus dem 

übergeordneten Schaltplan übergeben werden soll. Für unser Beispiel soll auch die 

Masseverbindung entfernt werden. Sie wird später durch einen eigenen Referenz-

punkt ersetzt. Dies bringt den Vorteil, dass das Eingangssignal des Tiefpass nicht 

unbedingt auf Masse referenziert sein muss. Um später die Verbindung zum Symbol 

herzustellen, müssen alle Signale, die mit der übergeordneten Ebene verbunden 

werden sollen, mit einem Namen versehen werden. In unserem Fall wäre das jeweils 

ein Eingang, Ausgang und Referenzpunkt. Die Vergabe von Namen für bestimmte 

Knotenpunkte erfolgt mit der Labelfunktion. Sie kann entweder mit der <N> Taste 

oder unter 

 Edit > Label Net 

gefunden werden. Da die Namen der Labels später im Symbol erscheinen, sollten sie 

sinnvoll gewählt werden. Die Werte von Kapazität und Widerstand werden durch 

Variablen ersetzt, damit sie als Parameter übergeben werden können. Dazu müssen 

die Variablen in geschweifte Klammern gesetzt werden. Abbildung 6 zeigt den ferti-

gen Schaltplan. 
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Abbildung 6: Schaltplan für den Hierarchical-Block Tiefpass 

 

Neben dem Schalplan wird auch ein Symbol benötigt, welches später in den überge-

ordneten Schaltplan eingefügt werden kann. Im LTspice Fenster unter 

 File > new Symbol 

öffnet sich eine Oberfläche zum Zeichnen von Symbolen. Um dieses Beispiel einfach 

zu halten, wird für den Tiefpass einfach ein leeres Rechteck mit Beschriftung ge-

wählt. Mit Hilfe der Zeichenfunktionen können selbstverständlich auch komplexere 

Zeichnungen als Symbole dienen. 

Zunächst überlegen wir uns, wie viele Pins das Symbol des Tiefpasses benötigt, und 

fügen diese in den Symboleditor ein. Die Funktion zum Hinzufügen eines Pins findet 

sich unter 

 Edit > Add Pin/Port 

oder standardmäßig mit der <P> Taste. 

Im erscheinenden Dialogfenster kann dem Pin ein Label zugewiesen werden. Hier 

erfolgt die Verknüpfung zwischen Schaltplan und Symbol. Um einen Pin des Sym-

bols mit einem Knotenpunkt auf dem Schaltplan elektrisch zu verbinden, müssen 

beide dasselbe Label tragen. 

Im Bereich „Pin Label Justification“ kann die Position des Labeltextes relativ zum Pin 

gewählt werden. Nach der Positionierung wird der Text „Tiefpass“ eingefügt und 

ein Rechteck um unser Symbol gezeichnet (beides findet sich im Menü „Draw“). Das 

Ergebnis zeigt Abbildung 7. 

 



  Anlegen eigener Modelle 

 

  16 

 

Abbildung 7: Hinzufügen eines Pins zum Tiefpasssymbol 

 

Bereits jetzt ist es möglich, Kapazität und Widerstand als Parameter zu übergeben, 

wenn das Symbol unseres Tiefpasses verwendet wird. Es wird jedoch empfohlen 

Standardwerte zu definieren und anzuzeigen, damit sofort offensichtlich ist wie der 

Tiefpass eingestellt werden kann. Dazu benötigt man das Attributfenster unter 

 Edit > Attributes > Edit Attributes 

Die Zeilen „SpiceLine“ und „SpiceLine2“ können zur Übergabe von Parametern ge-

nutzt werden. In jeder Zeile können mehrere Parameter (jeweils getrennt durch ein 

Leerzeichen) übergeben werden. Da in unserem Beispiel gerade 2 Parameter benötigt 

werden, werden beide Zeilen genutzt. Die Definition der Standardwerte (willkürlich 

gewählt) erfolgt mit den Zeilen 

 R=1k 

 C=1u 

(Abbildung 8). In der Zeile „Description“ kann eine kurze Beschreibung des Bauteils 

eingefügt werden. Sie erscheint später in der Bauteildatenbank und hilft so schnell zu 

erkennen, welche Funktion das Bauteil hat. 
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Abbildung 8: Bearbeiten der Symbolattribute 

 

Um die Attribute am Symbol sichtbar zu machen, muss unter 

 Edit > Attributes > Attribute Window 

das Attributfenster geöffnet werden. Hier können die Attribute ausgewählt werden, 

die neben dem Symbol angezeigt werden. Die Auswahl heftet das Attribut wie ge-

wohnt an den Mauszeiger von wo aus es dann platziert werden kann. Schließlich 

wird das Symbol gespeichert. Als Speicherort empfiehlt sich bei einmaliger Nutzung 

das Arbeitsverzeichnis der Simulation, in der der Tiefpass später verwendet werden 

soll. Der Name des Symbols muss der gleiche sein wie der des Schaltplans, damit 

LTspice weiß, welcher Schaltplan verwendet wird. 

Damit das neue Symbol in der Bauteildatenbank auftaucht, muss LTspice beendet 

und neu gestartet werden. 

Hinweis: Nach dem Öffnen von LTspice wird automatisch das Installationsverzeich-

nis als Arbeitsverzeichnis gewählt. Erst wenn der geöffnete Schaltplan im Arbeits-

verzeichnis abgespeichert ist, kann dieses als Quelle von Bauteilsymbolen in der Bau-

teildatenbank ausgewählt werden. 

Bei der Arbeit mit den selbst definierten Hierarchical Blocks ist es wichtig, Parame-

ter, die für die Einstellung des Blocks notwendig sind, immer über das Attributfens-

ter zu übergeben. Eine Änderung des Werts innerhalb des untergeordneten Schalt-

plans wirkt sich dann auf alle Schaltpläne aus, die den Block verwenden. 

Wird dieser Grundsatz befolgt unterscheidet sich die Nutzung von Hierarchical 

Blocks nur in zwei Punkten. Erstens ist dem Hierarchical Block ein grafisches Modell 

(Schaltplan) hinterlegt. Daher ist es möglich auch zu einem späteren Zeitpunkt die 

Funktion nachzuvollziehen. Der wesentliche Nachteil ist jedoch, dass alle Hierarchi-

cal Blocks innerhalb des Arbeitsverzeichnisses gespeichert werden müssen. Sollen 

manche für mehrere Simulationen verwendet werden, ist der Speicherort für neue 

Projekte immer eingeschränkt. Hier bieten die Subcircuits den Vorteil etwas flexibler 
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zu sein (siehe Kapitel 5.1). Da hier jedoch eine Netlist zu Grunde liegt, ist es schwie-

riger die Funktion eines Modells nachzuvollziehen und erfordert die Kenntnis der 

SPICE-Syntax. 

5.3 Subcircuits 

Wie bereits erwähnt liegen Subcircuits Netlists zu Grunde. Diese müssen jedoch 

nicht unbedingt mit Hilfe eines Editors als Code programmiert werden. LTspice bie-

tet die Möglichkeit die Netlist eines Schaltplans anzuzeigen. Von hier aus kann der 

Code dann kopiert werden. 

Als Beispiel für die Erstellung eines Subcircuits soll wieder unser Tiefpass dienen. 

Das Symbol, das wir bereits für den Hierarchical Block gezeichnet haben kann unter 

anderem Namen abgespeichert werden. Als Speicherort empfiehlt sich hierfür ein 

eigens angelegter Ordner unter 

 C:\Programme\LTC\LTspice IV\lib\sym\<meineSym> 

in dem alle selbst erstellten Symbole gesammelt werden (siehe auch Kapitel 5.1). 

Dann muss das Symbol geöffnet und für die Nutzung mit einer Netlist vorbereitet 

werden. Entgegen der Verknüpfung von Symbol und Schaltplan beim Hierarchical 

Block wird im Fall des Subcircuits eine elektrische Verbindung nur dann hergestellt, 

wenn die „Netlist Order“ des Pins im Symbol gleich der Bezeichnung des Knoten-

punktes in der Netlist ist. Mit einem Rechtsklick auf einen Pin am Symbol öffnet sich 

das bekannte Dialogfenster. Je nach der Reihenfolge des Hinzufügens zum Symbol 

haben die Pins eine aufsteigende Netlist Order. Im vorliegenden Beispiel lautet die 

Reihenfolge 

 

Pin Label Wert 

IN 1 

TGND 2 

OUT 3 
 

Tabelle 3: Netlist Order der Pins des Tiefpasssymbols 

 

Diese Information ist wichtig, um später die korrekte Verbindung zwischen Knoten-

punkt und Symbolpin in der Netlist herzustellen. Weiterhin müssen die Attribute 

des Symbols im Attributfenster 

 Edit > Attributes > Edit Attributes 

angepasst werden. 
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Abbildung 9: Anpassen der Symbolattribute für die Nutzung als Subcircuit 

 

Der Symboltyp für einen Subcircuit ist Cell. Als Prefix wird X (wie auch schon beim 

Hierarchical Block) eingetragen, um anzuzeigen, dass es sich hier nicht um ein Ba-

sismodell, sondern einen Subcircuit handelt. In der Zeile SpiceModel wird der Name 

des Modells hinterlegt. Dieser Name kann frei gewählt werden. Er wird später in die 

Netlist eingetragen. Die Übergabe der Parameter erfolgt wie auch beim Hierarchical 

Block mit SpiceLine und/oder SpiceLine2. Description enthält wie gewohnt eine kur-

ze Beschreibung, die später im Dialogfenster der Bauteildatenbank angezeigt wird. 

Zum Schluss muss dem Simulator noch gezeigt werden, wo er das oben eingetragene 

Modell finden kann. Für unser Beispiel soll die Quelldatei später im Ordner 

 C:\Programme\LTC\LTspiceIV\lib\sub\meinOrdner 

abgespeichert werden. Damit ist die Anpassung des Symbols abgeschlossen. Die 

Netlist, mit der das Symbol verbunden werden soll, gewinnen wir aus dem bereits 

gezeichneten Schaltplan des Tiefpasses. Dieser kann unter 

 View > SPICE Netlist 

als Netlist angezeigt werden (Abbildung 10). 
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Abbildung 10: Anzeigen der Netlist des Tiefpassbeispiels 

 

Es ist zu erkennen, dass die Netlist aus nur zwei Bauelementen (R und C) besteht. 

Wie bereits in Kapitel 3.1 beschrieben sind in der Netlist nur Basiselemente verzeich-

net. Die Syntax einer SPICE-Netlist wird in der LTspice Hilfe im Kapitel  

 LTspice > Introduction 

beschrieben. 

Bevor die Netlist kopiert wird, müssen alle Knoten mit der Netlist Order des ent-

sprechenden Pins am Symbol  

Tabelle 3)  benannt werden (Labelfunktion). Dann sieht die automatisch generierte 

Netlist so aus. 

 

Abbildung 11: Automatisch generierte Netlist des vorbereiteten Schaltplans 

 

Um aus der Netlist einen Subcircuit zu machen, muss der Text der Netlist kopiert 

und in einen Texteditor eingefügt werden. Der Aufruf eines Subcircuit erfolgt durch 

die Direktive 

 <.subckt modelName n1 n2 n3 n4 > 
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Die endgültige Beschreibung unseres Tiefpassmodells kann wie in Abbildung 12 

aussehen. 

 

Abbildung 12: .sub-Datei des Tiefpassmodells 

 

Zum Verständnis von Abbildung 12 gilt es Folgendes zu beachten: Zeilen, die mit 

einem Stern <*> beginnen sind Kommentarzeilen. Kommentare, die einer Direktive 

noch in derselben Zeile folgen, werden mit einem Semikolon <;> begonnen. Die erste 

Zeile einer Netlist ist immer ein Kommentar. Zusammengefasst enthält unser Modell 

den Aufruf als Subcircuit, gefolgt vom gewünschten Modellnamen (muss keinen Zu-

sammenhang mit dem Dateinamen haben) und den Anschlüssen. Darauf folgt die 

Netlist des Schaltplans. Achtung: Ein Subcircuit muss mit der Direktive 

 .ends 

beendet werden. Die Quelldatei wird im .sub Format unter 

 C:\Programme\LTC\LTspiceIV\lib\sub\meinOrdner 

gespeichert. So wurde es zuvor auch in der Attributliste des Symbols vermerkt. 

Um den Tiefpass zu verwenden, muss LTspice beendet und neu gestartet werden. 

Danach erscheint in der Bauteildatenbank der Ordner <meineSym> und darin das 

Symbol <tiefpass>. 

 

Abbildung 13: Dialogfenster der Bauteildatenbank 
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6 LTspice Tastaturkürzel 

LTspice verfügt über eine große Anzahl von vereinfachenden Shortcuts. Diese sind 

nachfolgend aufgeführt: 

Schematic editor 

Place Component F2 Place Ground G 

Draw Wire Mode F3 Place Resistor R 

Place Netname F4 Place Capacitor C 

Delete Mode F5 Place Inductor L 

Duplicate Mode F6 Place Diode D 

Move Mode F7 Draw Lines - 

Drag Mode F8 Draw Rectangles - 

Undo F9 Draw Circles - 

Redo Sft-F9 Draw Arcs - 

Place Comment Text T Reset T=0 0 

Place SPICE Directive S Schematic Grid Ctl-G 

Unconn. Pin Marks U Rotate Ctl-R 

Text Anchor Marks A Mirror Ctl-E 

Zoom Area Ctl-Z Halt Simulation Ctl-H 

Zoom Back Ctl-B Run Simulation - 

Delete Del Delete Ctl-X 

Copy Ctl-C Paste Ctl-V 

Place Bus Tap -   

Hint: Use Zoom-to-fit then Print in order to fill the page 

 

Symbol editor 

Object Anchors O Draw Rectangles R 

Place Pin P Draw Arcs A 

Delete Mode F5 Draw Circles C 

Duplicate Mode F6 Rotate Ctl-R 

Move Mode F7 Mirror Ctl-E 

Drag Mode F8 Attribute Editor Ctl-A 

Undo F9 Attribute Window Ctl-W 

Redo Sft-F9 Zoom In Ctl-Z 

Place Comment Text T Zoom Back Ctl-B 

Draw Lines L Show Pin Table - 
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Waveform editor 

Zoom Extents Ctl-E Reload Plot Settings File - 

Zoom Area Ctl-Z Label Cursor Position - 

Zoom Back Ctl-B Place Text on the Plot - 

Vertically Autorange Ctl-Y Draw an Arrow on the Plot - 

Toggle Grid Ctl-G Draw a Line on the Plot - 

Delete Mode F5 Draw a Box on the Plot - 

Add Trace Ctl-A Draw a Circle on the Plot - 

Add Pane - Annotation Line Style/Color - 

Undo F9 Move Plot Annotations - 

Redo Sft-F9 Drag Plot Annotations - 

Run Simulation - Redraw Window - 

Halt Simulation Ctl-H Select Steps - 

Open Plot Settings File -   

 

 

Netlist editor 

Goto Line Number Ctl-G   

Run Simulation Ctl-R   

Pause Simulation -   

Halt Simulation Ctl-H   

Undo F9   

Redo Sft-F9   

 


